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1. Introduction

Perforce offers excellent tools to allow users to both create new branches, and to merge code modified in one branch to another. Perforce tracks this branching and merging actity, and even provides a graphical tool in P4V called a Revision Graph to view this information. To see a revision graph, right-click on the name of a file  in either the Depot Tree or the Workspace Tree located on the left side of the P4V main screen (see Figure 1: Opening a Revision Graph below).
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Figure 1: Opening a Revision Graph
The revision tree of  //depot/Efp/Fasl/MAIN/FASLClientApplication/FASLApplication/AssemblyInfo. is shown in Figure 2 above. The branch MAIN is on top, and other branches are shown below. Solid arrows show when a branch was created. Other arrows show various merging operations between the branches. Perforce tracks these relationships between the branches, so it knows where a particular change in the file came from and in what version.
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Figure 2: Revision Graph for FASL’s AssemblyInfo.cs File
Since Perforce tracks this information, it is important to use Perforce to do the actual merge operations instead of manually copying the changes from branch to branch. Perforce does an excellent job of handling merges and will pick up changes that the user may have forgotten to carry over.

This document will show you how to handle branching and merging operations in Perforce from both the Perforce command line, and from the P4V Perforce graphical interface program.

2. Creating a branch in Perforce

Perforce uses the Integrate command to both create a branch, and to merge one branch into another. To create a branch in Perforce from the command line, use p4 integrate:
$ p4 integrate //depot/Efp/Celox/MAIN/... //depot/Efp/Celox/CELOX-4.0.1/...

This command will branch the MAIN branch on Celox to a branch called CELOX-4.0.1. Remember that no changes will be made to the Perforce source depot until these changes have been submitted. This includes newly created branches. Once the new branch has been submitted, other users will then see the new branch.
Creating a branch in P4V is done by right-clicking on the name of the branch in the Depot or Workspace tree and selecting the Integrate selection from the context menu. (See Figure 3: Running the Integration command from P4V below). 
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Figure 3: Running the Integration command from P4V

Perforce will bring up the Integrate Dialog Box (see Figure 4: Creating a New Branch CELOX-4.0.1.) To create a new branch, select the File Specification tab, and change the name of the branch in the Destination field to the name of the branch that is being created. Then, press the Integrate button. Again, remember that the newly created branch is not part of the source depot and visible to other users until those changes are submitted.
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Figure 4: Creating a New Branch CELOX-4.0.1

2.1 Merging Changes from the Parent Branch to the Child Branch

To merge a changes that occurred in the parent branch to a child branch, rerun the integrate command. Perforce will compare the child branch and the parent branch and only bring over the latest changes.
Once the integrate command is completed, changes moved over to the child branch need to be resolved the changes can be submitted back into the source depot.

To resolve the merges from that resulted from the integration, first run the p4 sync command to schedule the resolve, and then run the p4 resolve command to actually resolve the changes.
$ p4 integrate ./MAIN/... ./CELOX-4.0.1/... #Integrates the changes

$ p4 sync    #Causes Perforce to schedule the resolve

$ p4 resolve <parameters> #Resolves all of the integrated files

You may specify which files you want to resolve by specifying them at the end of the p4 resolve command. Otherwise, the p4 resolve command will be executed against all files opened by your p4 integrate command. You may specify the following command line parameters when executing the p4 resolve command:

	Command Line Parameter
	Description

	-am
	Accept Merges: Perforce performs merges if there are no conflicts and will use the merged results as the accepted version of the file. Otherwise, Perforce will simply skip this file, and it must be manually resolved. Binary files will automatically be skipped.

	-as
	Accept Safe: Perforce does no merges. Instead, if one version of the file has changed on one branch, but not the other, it will accept the changed version of the file. Otherwise, if both files have been changed, Perforce will skip the file. Binaries are always skipped.

	-at
	Accept Theirs: Perforce does no merges. Instead all changes on the source branch are simply copied over to the destination branch. This includes binaries. Yes, the terms theirs and yours are confusing. Live with it.

	-ay
	Accept Yours: Perforce does no merges. Instead all changes on the target branch are used and no copying is done. Yes, the terms theirs and yours are confusing. Now, get over it.

	-af
	Accept Force: Perforce performs the merge, and even if the merge results in a conflict, will use the merged file. You must remember to go through the merged files and fix these conflicts.

	-db
	Disregard Blanks: Ignore differences in whitespaces on the same line, but won’t ignore line endings.

	-dw
	Disregard Whitespace: Ignore line endings and whitespaces. Note that the resolve command will use the client’s text whitespacing when resolving whitespace conflicts.

	-f
	Force: Force files to be re-resolved. This is useful when you ran “p4 resolve” once, and then want to dispose of the changes.

	-n
	Nothing: Don’t do anything, just show the actions Perforce would take if this flag was not given

	-t
	Text merge binaries: Do a textual merge even if the file is officially a binary type.

	-v
	Verbose Markings: Put conflict markers in all files even if the files have no conflicts. You must manually edit out the conflict markers.


If you do not specify the -am, -as, -at, -ay, or -af parameter, the p4 resolve command runs in interactive mode. This will bring up each and every unresolved file, and allows you to specify how you want to handle that particular file. The following is a list of the p4 resolve interactive commands:

	Command
	Description

	at
	Keep only changes to their file.

	ay
	Keep only changes to your file.

	am
	Keep merged file.

	ae
	Keep merged and edited file.

	a
	Keep autoselected file.

	dt
	See their changes alone.

	dy
	See your changes alone.

	dm
	See merged changes.

	d
	Diff your file against merged file.

	et
	Edit their file (read only).

	ey
	Edit your file (read/write).

	e
	Edit merged file (read/write).

	m
	Run '$P4MERGE base theirs yours merged'.

	s
	Skip this file.

	h
	Print this help message.


Note that the p4 resolve command can be executed multiple times as shown in the following example:

$ # Resolve all safe changes first

$ p4 resolve –as
# In./foo dir, copy parent changes to remaining unresolved files

$ p4 resolve –at ./foo/...

# In ./bar/ dir, keep child changes in remaining unresolved files

$ p4 resolve –ay ./bar/...

# Now, resolve the rest interactively

$ p4 resolve

To resolve the files from P4V, right-click on the changelist or the individual files you want to resolve. Then, select Resolve from the drop down menu as shown in Figure 5: Resolving all files in the default changelist below.
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Figure 5: Resolving all files in the default changelist

After you select Resolve from the context menu, the Resolve dialog box will appear.
There are two ways of resolving changes inside the Resolve dialog box: Auto and Interactive. The Auto mode is like running the p4 resolve command with either the -am, -as, -at, -ay, or -af parameter command line options.

It is usually advisable to resolve the files first in Auto mode, then go back and resolve the remaining files in Auto mode. Like the p4 resolve command, Resolve may be executed multiple times until all files are resolved.

In the Auto mode, the safest option is the Accept changed files (only one file differs from the base (see Figure 5 below). It is equivalent to the command line p4 resolve -as command. If the parent file has changed since the last revision, but the child file hasn’t, the parent file is copied over and the file is marked as resolved. If the child file has changed since the last revision, but not the parent file, the child version is kept, and the file is marked as resolved. Otherwise, the file is kept in an unresolved state.
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Figure 6: Automatically resolving the safest way
Accept changed file (only one file differs from the base).
If the Interactive resolve is selected a second Resolved dialog box (see Figure 7: Running the Merge Tool) will be displayed and will be executed for each file in the Files to resolve list.
For each file, the user may select to accept the proposed merge (Accept Merged), keep the target file unchanged (Accept Target), or copy the source file over the target files (Accept Source). Under the Additional Options, the user may also run the merge tool itself on the individual file and select how to handle each individual merge point in the file. The other four buttons in the Additional Options section allow the user to examine the source, target, and base files, diff them against each other, or examine their history.
[image: image7.png]Resolve (scsmerldcs02:1666, nbkén2b)

Fies o esclve:

@ Resolve fous/arge] @ Resolve Wit (teis/source)

CApdclients\celo CELOX40 ACelonbu.. (9 /depot/Efp/Celow MAIN/Celow/buld elease] .
C\pdclints\celon\CELOX40.1ACekostbu.. (9] /depot/Efp/Celos/MAIN o buid [debuglc
CApdelints\celo\CELOX-4.0.1\Cekot Ce.. () /depot/Efp/Celow/MAIN/Celon/Celon bd #6
C\pdelints\celon\CELOX-4.0.1ACelortbu.. (9 //depot/Efp/CelowMAIN Celon/buid CeosStan
Ci\pdclints\celo\ CELOX-4.01\Celortch.. (9 /depol/Efp/Celow MAIN/Celn/cheskouCelo
Ciipaclientshoslon CELOX-4.01\Celowtup... ] //depol/Efp/CalowMAIN/Calon/updaterets.omd .|

Recommended acton:
Click the "Accept Source” button below.
Orly soce il diersfrom the comon base e

Commonbase (9] //depol/Efp/CelowMAIN/Celow pdaterfs cmd H5
Soucefle  Diferences fiom base: 2
Tagetfle  Diferences fiom base:

Corfcts: 0

Merged resuit

Reesolve oplions:

(ot ] sk i o i e skttt s
P et
s

Addiional aptions:

[runtieyton | [Dpenfie.~] [0 ] [Firitay +] [Tmclmviene





Figure 7: Running the Merge Tool

When the user selects to Run Merge Tool, the P4Merge dialog box is brought up. This dialog box shows the base, target, and source files in the top half of the dialog box with the merged file in the bottom half of the dialog box ( See Figure 8: The Merge Tool). Directions on using the P4Merge merge tool is available from the Help menu.
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Figure 8: The Merge Tool

3. Branch Specifications

Although they are sometimes referred to as branches, a branch specification is not a branch. There can be a branch specification without a corresponding branch, a branch without a corresponding branch specification, and there can even be a branch specification that does not match its own branch.

Branch specifications are optional records that describe the relationship between branches in Perforce. A branch specification may be created at any time, even after the branch that it describes was actually created. A branch specification is useful once the relationship between the branches becomes more complex such when the directory structure between two branches start to diverge. In this case, a branch specification can help maintain these differences.

To create a branch specification, use the p4 branch command from the command line. To create a new branch specification in P4V, go to the File menu and select New(Branch Specification…. 
Figure 9: Branch Specification for CELOX-4.0.1 branch shows a branch specification between a branch called MAIN and a branch called CELOX-4.0.1.

The first line under the View field tells Perforce that there is a relationship between the Perforce depot directory //depot/Efp/Celox/MAIN/… and //depot/Efp/Celox/CELOX-4.0.1… This is the simplest relationship between two branching directories, and if the entire branch specification consisted of this one line, the following commands would be equivalent:
$ # Creating Branch CELOX-4.0.1 with a Branch Specification


$ p4 integrate –b CELOX-4.0.1
$ # Creating Branch CELOX-4.0.1 without a Branch Specification

$ p4 integrate //depot/Efp/Celox/MAIN/… //depot/Efp/Celox/CELOX-4.0.1/…

Branch specifications are much more useful once the directory and file structure between the two branches start to diverge. The second line under the View field in Figure 9 shows one change in the directory structure between the two branches. In this case, the file main.cp in the MAIN branch was renamed Main.cpp in the branch CELOX-4.0.1. If an integrate is done from MAIN to CELOX-4.0.1 without a branch specification, Perforce would try to delete Main.cpp and in main.cp each time. Even worse, changes that were made to main.cp in MAIN would not be merged into Main.cpp in CELOX-4.0.1. In this case, the branch specification helps the integration maintain a mapping between main.cp in branch MAIN and Main.cpp in branch CELOX-4.0.1
The third line  in the branch specification tells Peforce that the file obsolete.cs in branch MAIN branch has been deleted in branch CELOX-4.0.1. Without this branch specification, Perforce would attempt to recreate this file in branch CELOX-4.0.1 each time an integration is done. The last line tells Perforce that the files in directory dir1 in branch MAIN has been merged into dir2 on the CELOX-4.0.1 branch. 
The syntax for branch specifications under the View field is quite rich, and can be used to help remap the relationship between various files between two branches as their directory and file structure diverge. Complete help for the branch specification syntax is available from the Perforce Users Guide
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Figure 9: Branch Specification for CELOX-4.0.1 branch

3.1 Integrations with Branch Specifications

A branch specification can be used to create a branch and to merge files via the p4 integrate command. Istead of specifying the directory mapping on the command line, the -b command line option is used, and the branch specification’s name is given. An example is shown below:
$ p4 integrate –b CELOX-4.0.1

Although the branch specification was created with the mapping from the parent branch to the child branch, the same branch specification can also be used when integrating from the child branch back to the parent branch by telling the p4 integrate command to reverse the mapping.

$ p4 integrate –b CELOX-4.0.1 –r

To use a branch specification in P4V, bring up the Integrate dialog box as shown in Figure 3: Running the Integration command from P4V above. However, select the Branch Specification tab instead of the File Specification tab, and give the branch specification name under the Branch field. See Figure 10: Integrating with a Branch Specification below.

If the integrate operation is going from the child branch back to the parent branch, make sure that the Reverse mappings in branch view (-r) checkbox selected as show below in Figure 10: Integrating with a Branch Specification .
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Figure 10: Integrating with a Branch Specification
(Note that “Branch Specification” tab is selected. Also note the location of the “Reverse mappings in branch view” checkbox)

4. Branches that Diverge vs. Branches that Converge
A child branch can either converge or diverge from the parent branch. For example, when a release branch is created, it will diverge from the parent branch. This is not so much as the release branch diverging from its parent branch as much as the parent branch adding new features that are never added to the release branch. Two months from now, the differences between the release branch and its parent branch will be much greater than they are today. And, in two years, the differences between the release branch and its parent branch will be even greater.

On the other hand, special development branches that add a feature that will be incorporated back into a parent branch tend to converge with the parent branch. When parallel development is done in this fashion, it is important to keep all the changes in the parent branch merged back into the development branch. Once the special development is complete, the changes from the parent branch are once more merged back onto the development branch, and the development branch is copied back to the parent branch. At this point, the two branches should be identical. Therefore, in this situation, development branches converge with their parent branch.

5. Divergent Branching with Perforce

Perforce was designed to handle the merging of code back and forth between divergent branches such as a release branch. Figure 11: Merging between Release and Main Branches show a typical situation in Perforce. A release branch was created based upon revision #3 on the Main branch. In revision #4 on Main, a defect was fixed. This change needs to be merged to the Release branch, but without any other changes on the Main branch going into the Release branch. When the release branch is complete, all changes on the Release branch needs to be merged back into the Main branch.
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Figure 11: Merging between Release and Main Branches

The following shows how this back and forth merging is handled in Perforce on both the command line and through the P4V graphical interface.

In the first part of the scenario, a defect was discovered in revision #2 on the Main branch, fixed in revision #3, and this change now needs to be integrated into the release branch. However, there are other changes on the main branch that should not be brought over to the release branch. Perforce allows users to limit integrations to a small select group of changes. 

This single change can be integrated into the release branch using the p4 integrate command as shown below. In this case, the integration is limited to just revision #4 of the AssemblyInfo.cs file
. Notice the revision information tacked onto the end of the AssemblyInfo.cs.
$ p4 integrate ./MAIN/AssemblyInfo.cs#4,4 ./REL_1.0/AssemblyInfo.cs

Like p4 integrate, P4V also allows a user to specify a select range of revisions when doing an integration as shown in Figure 12 below. Notice this is specified in the Source Revision Range area of the Integrate dialog box limits the integration just to revision #4 of the AssemblyInfo.cs file
.
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Figure 12: Integrating only revision #4 of AssemblyInfo.cs on MAIN back to REL_1.0 branch. Note where revision is specified in Source Revision Range field.
Integrating changes from a release branch back to the parent branch is usually much easier since all changes done on the release branch should normally be integrated back into the main branch. In this case, a normal p4 integrate is done:
$ p4 integrate //depot/Efp/Fasl/REL_1.0/... //depot/Efp/Fasl/MAIN/...

Notice that no version information is specified in this instance. Branch specifications can also be used:

$ p4 integrate –b REL_1.0 –r

The -r specifies that the mapping defined in the branch specification needs to be reversed since this integration is going from the child branch to the parent branch.

From P4V, this can be done via the Integrate dialog box as shown in Figure 13. Notice that the Source Revision Range should be left blank.
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Figure 13: Merging all changes from a Release Branch back to Main. (Note the Source Revision Range)

6. Integrating Convergent Branches
The previous section covered how Perforce handles integrations between branches when those branches diverge from each other. In that case, information is merged back and forth between the two branches. However, there are times when two branches converge with each other. For example, a special development branch is created to work on long term development. In this case, changes done on the parent branch should be merged into the development branch (so the development branch remains in sync with the parent branch). However, when the development work is completed and the development branch is integrated back into the parent branch, the parent branch should be a copy of the development branch.
In this case, it would seem that the easiest solution is to simply checkout all files on the parent branch, and copy the files from the development branch to the parent branch. However, this means that Perforce is not being informed about the integration that is going on between the two branches which can cause problems with future integrations between the two branches. Plus, a simple copy may not take into account any changes in the directory structure between the two branches.

It is important to use Perforce’s integration tracking when delivering code from a development branch back to its parent branch. The following section will show how to accomplish this in Perforce.
6.1 Using the Command line to Integrate Convergent Branches
This section covers using the p4 command line to integrate code from a child branch back to the parent branch when those two branches converge. Notice this is not used for merging code from the parent branch into the converging child branch since that is a true merge operation. Using this method to go from the parent branch to the child branch will lose all changes made on the child branch.
1. Verify that there are no opened files in this client: Before delivering the changes from a convergent child branch, make sure that no other files are opened on the client. The p4 opened command will list all files that are currently open for edit on the client:
$ p4 opened

Files that are opened on the client should first be either submitted or reverted before continuing. That way, the changelist is kept clean and all changes on the changelist belong to this single task.
2. Verify that all changes on the parent branch have already been integrated into the child branch: Since the end of this procedure will make the parent branch a duplicate of the child branch, it is extremely important to verify that all changes on the parent branch have been incorporated into the child branch. This can be done using the p4 integrate command in the -n option. The -n option does not execute the command, but merely lists what that command will do. 
$ p4 integrate –n ./MAIN/... ./CELOX-4.0.1/...

If any integrations between the parent and child branches are reported by this command, these changes must be integrated into the child branch before continuing.

3. Force the integration of all files from the child branch to the parent branch: All changes on the child branch needs to be integrated into the parent branch even if Perforce believes those changes should not be integrated. For example, a change was done on the parent branch, but for a variety of reasons, never implemented on the child branch. Normally, Perforce will not integrate the file found on the child branch back into the parent Using the -f option will force Perforce to integrate the file on the child branch even if it normally wouldn’t be integrated:

$ p4 integrate –f ./CELOX-4.0.1/... ./MAIN/...

4. Resolve all changes by copying the files from the child branch over the files on the parent branch: Once the integration is completed, resolve the changes using the p4 resolve command with the ‑at flag to copy all files on the child branch onto the parent branch:

$ p4 resolve –at

5. Revert unchanged files: Since the -f command line parameter was used with the p4 integrate command, all files were copied from the child to the parent branch – even files that were never changed. Therefore, the user needs to revert all files that have not been changed. Unfortunately, since the files are opened for integration, the standard p4 revert -a command will not work. Use the p4 diff command to find all files that do not differ from their predecessor version, and pass that output to the p4 revert command.

$ p4 diff –sr | p4 –x – revert

6. Run a second Integration: Sometimes, a file was changed in one revision and reverted in the next revision. In the previous command, these files will have been reverted too since they is no difference between the two revisions on the two branches. However, Perforce still needs to be able to track this in its integration history. Running p4 integrate again without the force flag will allow Perforce to track these changes.

$ p4 integrate ./CELOX-4.0.1/... ./MAIN/...

7. Resolve all files one last time: If any files were opened by the previous integration command files need to be resolved. Run the p4 integrate command again to resolve these changes. Use the -at flag to copy all files from the child branch to the parent:
$ p4 resolve –at

8. Submit the changes: The integration is complete. Other Perforce users may once more submit changes onto the parent branch.
$ p4 submit

6.1.1 Review

Below are the p4 commands used in the convergent integration above.
$ p4 opened
$ p4 integrate –n ./MAIN/... ./CELOX-4.0.1/...

$ p4 integrate –f ./CELOX-4.0.1/... ./MAIN/...

$ p4 resolve –at

$ p4 diff –sr | p4 –x – revert

$ p4 integrate ./CELOX-4.0.1/... ./MAIN/...

$ p4 resolve –at

$ p4 submit

6.2 Using P4V for Integrating Convergent Branches
Convergent merging of a child branch back to a parent branch can also be done via the P4V tool. However, the ability to revert unchanged files that have been opened through the integration is not natively supported in the P4V tool itself. In order to get around this issue, you will need to add this ability to P4V via the Tools menu.
6.2.1 Setting Up P4V to do Convergent Integration.
Before a convergent integration can be done in P4V, a custom tool must be added to allow for reverting unchanged files held opened by an integration. Go to the Tools menu and select Custom Tools as shown below. This will bring up the Custom Tools dialog box.
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Figure 14: Adding a Custom Tool in P4V

In the Custom Tools box, select the Custom Tools icon in the Custom tools menu: field, and click on the Add Tool… button. This will bring up the Add Custom Tool dialog box.
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Figure 15: Adding a Custom Tool

Next fill in the dialog box as shown below. Make sure you’ve got the following fields set:
· Name: Call this Revert Unchanged Integrated Files
· Placement: Leave this in the Custom Tools main folder
· Add to applicable context menu: Make sure this is checked.

· Application: This should just be either just  p4.exec, or if the location of the directory where p4.exe itself is located is known, the full folder hierarchy can be included (usually located in C:\Program Files\Perforce\p4.exe). The latter is preferable because it means that this will work even if the PATH environment variable isn’t setup to find the p4v.exe command.
· Arguments: This should be diff -sr | p4 -x - revert. Note that the -x is followed by a space then, a lone dash, then another space. The vertical bar before the second p4 is found right above the Enter key on most keyboards.
· Starts In: Leave blank

· Run in terminal window: Make sure this checkbox is selected.

· Close window upon completion: Check this checkbox to automatically close the command window when finished. However, if you want to see the result of the command, leave this unchecked, and you can manually close the command window that pops up when this command is executed.

· Refresh P4V upon completion: Make sure this checkbox is selected.

Once these fields are filled in, click the OK button.
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Figure 16: Adding Revert Unchanged Integrated Files Command
Once this step is completed, P4V can be used for integrating convergent child branches back into their parent branch.
6.2.2 Running the Merge through P4V

1. Verify that there are no opened files in this client: Before integrating the changes from a convergent child branch, make sure that no other files are opened on the client. This can be done by making sure that the changelists listed in the Pending Changelists window are empty (see Figure 17).

Files that are opened on the client should first be either submitted or reverted before continuing. That way, the changelist is kept clean and all changes on the changelist belong to this single task.
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Figure 17: Verify no opened files in view
(Changelists are empty)
2. Verify that all changes on the parent branch have already been integrated into the child branch: Since the end of this procedure will make the parent branch a duplicate of the child branch, it is extremely important to verify that all changes on the parent branch have been incorporated into the child branch. 

This can be done by bringing up the Integrate dialog box, fill in the source and destination fields as if you were doing an integration from the parent branch to the child branch, and then pressing the Preview button instead of the Integrate button (See Figure 18 and Figure 19 below).
If any integrations between the parent and child branches are reported by this command, these changes must be integrated into the child branch before continuing.
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Figure 18: Verify that there are no changes that must be first incorporated from parent to child (use Preview button)
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Figure 19: Nothing need to be integrated into the Parent branch.

3. Force the integration of all files from the child branch to the parent branch: All changes on the child branch needs to be integrated into the parent branch even if Perforce believes those changes should not be integrated. For example, a change was done on the parent branch, but for a variety of reasons, never implemented on the child branch. Normally, Perforce will not integrate the file found on the child branch back into the parent. Selecting the Disregard all integration history (-f) option in the Integration dialog box (see Figure 20), will force Perforce to integrate the file on the child branch even if it normally wouldn’t be integrated
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Figure 20: Force Integration from Child to Parent
(Note Disregard all integration history is selected)
4. Resolve all changes by copying the files from the child branch over the files on the parent branch: Once the integration is completed, you will need to resolve your changes using resolve files. Right click on the name of the changelist that contains the files opened during the previous Integrate (probably the default changelist), and select resolve files as shown in Figure 21. Next, click on the Accept Theirs radio button and click the Auto button as shown in Figure 22.
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Figure 21: Resolve Files
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Figure 22: Resolve the Differences
(Note Accept Theirs is chosen)
5. Revert unchanged files: Since you selected the Disregard all integration history (-f) option when you did the integration, all files were integrated – even files that should not had been integrated. Therefore, the user needs to revert all unchanged files. Unfortunately, since the files are opened for integration, simply selecting the standard Revert unchanged files will not work. Therefore, the user needs to use the command added to Perforce in section 6.2.1. Setting Up P4V to do Convergent Integration. located above.

Right click on the changelist and select Revert unchanged Integrated Files as show in Figure 23.
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Figure 23: Revert Unchanged Integrated Files 

6. Run a second Integration: Sometimes, a file was changed in one revision and reverted in the next revision. In the previous command, these files will have been reverted too since they is no difference between the two revisions on the two branches. However, Perforce still needs to be able to track this in its integration history. This time, bring up the Integrate dialog box as shown in Figure 24 below as done in step #3, but this time, the Disregard all integration history (-f) checkbox is not selected.
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Figure 24: Second Integration
(Note Disregard all integration history is off)
7. Resolve all files once more: If any files were opened by the previous integration command files need to be resolved. Right click on the name of the changelist that contains the files opened during the previous Integrate (probably the default changelist), and select resolve files as shown in Figure 24. Next, click on the Accept Theirs radio button and click the Auto button as shown in Figure 25.
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Figure 25: Resolve once again with Accept Theirs
8. Submit the changes: The integration is complete, Submit the changes as shown in Figure 26.
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Figure 26: Step #8 – Submitting changes
� It would be limiting if Perforce required you to run a separate integration for each change on each file. However in Perforce, this type of integration would be normally done with changelists. A a changelist can be created for all defects fixed on the main branch that also need to be integrated to the release branch. Now, all of these changes can be integrated at once:


$ p4 integrate ./MAIN/...@1001,1001 ./REL_1.0/...


� And, just like the p4 integrate command, the P4V Integrate tool allows you to specify the range of the integration in changelists as well as revisions by changing the two drop down list in the Source Revision Range from Revision to Changelist.


� Once it has been determined that no more changes need to be integrated to the child branch. All Perforce users need to know not to submit any more changes into the parent branch until the final p4 submit is completed in step #8. If necessary, the Perforce protection table could be modified to prevent any more changes on the parent branch being submitted except by the user doing the integration.


� Do not use a branch specification in this step. 
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